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Like the proverbial frog in a gradually-warming pan of water, most of us find ourselves 
spending more and more time on the Internet; and most of that ever-increasing online 
activity is funnelled through a single piece of software – a Web browser. While other 
important applications such as word processing applications and spreadsheets were designed 
from scratch with a specific purpose in mind, web browsers have developed incrementally 
along with the web itself; and being free, they seldom undergo the same level of scrutiny and 
review that, say, Microsoft Office or Adobe Acrobat attract at budget time.

Now that the browser battleground – once a Microsoft walkover – has been reinvigorated by 
the arrival of Google Chrome and the increasing popularity of Mozilla Firefox, Fortuity Labs 
has decided it’s time to take a fresh look at web browsing. Some of their best and brightest 
have been allocated to a new Better Browsing Bureau, with a simple assignment: help clients 
obtain the most benefit and the least aggravation from their time online. Here are some 
extracts from their working brief.

Choosing a browser

A web browser has three basic functions: it looks up a URL, downloads a copy of what it 
finds there to your hard drive, and displays it on your screen. Interactive sites add a fourth 
function: sending back to the site the information that you enter. The earliest web browsers 
did very little other than interpret HTML code, and this is still a major part of their job: in 
fact all browsers are still equipped to let you look ‘behind the scenes’ at the raw code they 
are handling (check the bottom of the View menu for a ‘View Code’ or ‘View Source’ 
option). In the past different browsers interpreted the code in different ways, resulting in the 
WYSIWYWPGIYL syndrome among web designers – ‘What You See Is What You Will 
Probably Get If You’re Lucky’. But these differences have largely been resolved, and 
designers can now be reasonably confident that as long as they don’t get too fancy, their 
pages should look the same in every browser. 

Which browser to choose? Microsoft has an advantage because their Internet Explorer comes 
preinstalled on most Windows systems. But what about the new kids on the block – Mozilla 
Firefox, Google Chrome, Opera and the Macintosh Safari? Each set of users will 
passionately defend the browser of their choice, but anyone trying to make an objective 
judgment needs to look at three main factors:

• Speed – how fast does it start up and how quickly does it retrieve pages?

• Security – how vulnerable is it to attack and misdirection?

• Extensibility – how much can it be enhanced and customised?

The speed factor is a selling point for Opera, the browser developed in Norway, which 
claims to be both faster and safer than its rivals. The latest Opera also includes a new feature 
– a ‘trash can’ which stores the addresses of pages you’ve closed in case you change your 
mind and want to open them again. Firefox also makes a point of its speed, and there are 
hundreds of extensions written for Firefox by the open-source community which provide 
extra features like password encryption, phishing avoidance and – huzzah! – blocking 
advertisements. Google Chrome is a newcomer but catching up quickly with all those dollars 
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behind it.

Faced with these challenges Microsoft has been forced to lift its game, and the new Internet 
Explorer 8 has many improvements on the older versions: but at a minimum of 50 Mb (going 
way up if other components are added) it’s six times the size of Opera and seven times the 
size of Firefox: and it is much easier, as a result, for would-be hackers to find points of 
vulnerability. Another black mark for Microsoft: it remains obstinately locked to the 
Windows platform, while the other major browsers now offer support for Linux and 
Macintosh as well. Even the Safari Mac browser from Apple comes with a Windows version. 
And scaled-down versions of these browsers are now finding their way on to PDAs and 
mobile phones too.

Customising your browser

Choosing a browser is only half the story. The next step is to modify it to suit your 
requirements. Some users – especially those who are visually impaired – may need to make 
extensive changes; others may be able to get away with a few cosmetic tweaks. Whatever 
your needs, here are some options to consider:

1. Toolbars and panels. Use the View menu to decide which toolbars to make visible, 
and the Customise option to add and reposition the the toolbar buttons that you need 
and remove those you don’t. If you have a wide screen you might want to turn on the 
Sidebar (or Panel) option under View to display a panel at the left. By default this 
panel can show your bookmarks or your browsing history, but some add-ons like 
Delicious also provide Sidebar display options too.

2. Bookmarks / Links. If your Links toolbar (‘Bookmarks Toolbar’ in Firefox) is open 
you can drag web page addresses here from the address field. All browsers now come 
with a ‘Manage (or Organize) Bookmarks’ menu item which allows you to move 
bookmarks into folders and subfolders by category. One advantage of grouping 
bookmarks into folders is that you can then open all the bookmarks in a folder with 
one click; this is ideal for your daily review of the main news sites – or the comic 
strips.

3. Fonts and colours. Look under Edit/Preferences or Tools/Options to find the font and 
colour customisation settings for your particular browser. Users with ageing eyes 
may just want to turn the minimum font size up a little; those who are colourblind or 
visually impaired may need to make more drastic changes. Users who need complete 
control over the display of web pages can use the same method that web designers 
do, and attach cascading style sheet (CSS) files which specify in detail how each 
component of every page should appear. Meanwhile, for individual pages, you should 
be able to adjust the font size by holding down the Control key and rolling the mouse 
wheel.

4. Cookies. Cookies are small text files which are downloaded from the sites you visit 
and stored in a specific directory on your hard disk. The next time you visit the site, it 
can re-open its own cookie and find out when you were there last, along with other 
information that you may have entered like your name and password. There was 
some agitation over cookies in the early days of the web, but most people seem to 
have become resigned to them. If they become a nuisance you can turn them off via 
the Privacy settings under Tools / Options or Edit / Preferences. Cookies and other 
ongoing information retained by the browser can also be purged on a one-off basis 
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via the Clear (or Delete) Private Data command, usually found under the Tools menu.

5. Security settings. More worrying than cookies is the risk of losing control of your 
computer – or your bank account – via one of the deceptive ‘phishing’ sites which 
abound on the web. All browsers now have Security setting options which can warn 
you when you open a page considered dangerous. These settings also allow you to 
manage the passwords that your browser can store for eBay, PayPal and other 
passworded sites. Firefox and Opera, for instance, can be set to ask the user for a 
‘master password’ before they cough up the actual password for a protected site.

6. Add-ons / Plug-ins. All the major browsers support some kind of add-on (aka ‘plug-
in’) system for optional extras, but Firefox has the widest range by far. A look at 
addons.mozilla.org shows well over ten thousand of these, ranging from near-
essentials like advertisement blockers to frivolous toys like animated jugglers. There 
are also tools designed to work with popular online sites like eBay, Facebook, Flickr 
and YouTube. A few minutes spent here can save you hours of irritation wrestling 
with unwanted content and recalcitrant web pages later on. Similar but less 
comprehensive collections can be found online for Internet Explorer 
(www.ieaddons.com) Opera (www.opera.com/docs/plugins) and Google Chrome 
(www.mychromeaddons.com). Add-ons will occasionally conflict with another, or 
cause problems on certain pages, and if this happens they can be temporarily disabled 
or permanently uninstalled via the Tools menu.

7. Themes / Skins. Finally, with the hard work over, you can kick back and prettify your 
browser with Themes – aka ‘Skins’ in Opera and Chrome – which change its 
appearance but not (you hope) its functionality. For Firefox these can be found under 
the Add-Ons menu item, while Opera has a special ‘Appearance’ option under Tools. 
Internet Explorer is more resistant to customisation, but users who are particularly 
keen can find a few websites which explain how to tweak its appearance.

Synchronising and backing up

That’s one browser taken care of: but what if you’re browsing at home when you discover a 
useful site, and you want to have it available when you go into work the next day? Or you’re 
reinstalling your browser after a system crash, and you want to reinstate the same bookmarks 
you had before? Luckily there are bookmark and password synchronisation add-ons available 
for all major browsers.

For example, the Xmarks add-on for Firefox, Internet Explorer and Safari 
(www.xmarks.com) allows you to set up a free passworded account on the Xmarks site to 
store your bookmarks in. Any changes you make to your bookmarks can be uploaded to the 
Xmarks site, either automatically or on request. Move on to another computer, fire up your 
browser, and your modified bookmarks can be downloaded from Xmarks and installed to 
that PC. Users are given the choice of replacing all the current bookmarks or just adding to 
them. And any bookmark changes made on this computer can be uploaded in the same way, 
so that all your bookmarks remain current wherever you are working from. 

Xmarks offers the same service for passwords – suitably encrypted and protected, of course. 
Similar functions are available from Zinkmo (www.zinkmo.com), and not to be outdone, 
Google Chrome has built the feature into their latest browser version.

Users who want more security can backup their complete Firefox profile, including 
bookmarks, add-ons, themes and settings, with the FEBE extension, though this requires a 
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little more work to restore afterwards. FEBE also works with the free online storage site 
box.net to store your backups online, safely away from fire, flood and theft. Other online 
backup systems like SugarSync and DropBox can be set up to provide the same 
functionality.

URL shortening

Better browsing also means saving your clients’ and customers’ typing fingers. The 
aggravation that results from typing a long URL like 

http://www.webindexing.biz/index.php/clients-a-affiliations-mainmenu-44/59-indexing-
clients

(and getting it wrong and typing it again, and again) can be easily avoided. Considerate 
authors and web designers will make life happier for everybody by using short, punchy, URL 
aliases for those unforgivably long addresses. And there are plenty of sites which offer just 
that.

Longest-established and best-known is TinyURL (www.tinyurl.com), which works in three 
ways. Method One: type a long URL into the address field on its home page, and it will 
generate a short, permanent, unique alias for you. A user typing this address into their 
browser will be redirected to the original page via the TinyURL site. For example, the 
address above was transmuted into

http://tinyurl.com/ljyupj.

If someone has already created a TinyURL for that page, you’ll be referred to that, rather 
than a new one being generated.

Method Two is to concoct your own more memorable TinyURL address. For instance, I 
converted the teacher website for Cambridge Secondary Education at 

http://www.cambridge.edu.au/education/teacher/home.php?s=secondary&n=Home

into 

http://tinyurl.com/cb2ndary.

Custom addresses need to be unique, of course: you’re unlikely to be able to use a common 
word or name because someone will have almost certainly beaten you to it.

Finally, TinyURL capability can be added in to your web browser as an extension or plug-in 
in the form of a toolbar, an on-screen button and/or a menu option.

TinyURL is funded by advertising and donations, and its popularity has inspired many 
imitators, including a slowish and rather neglected knock-off site at www.tinyurl.com.au. 
More credible alternatives can be found via a Google search or from the long list at 
http://tinyurl.com/yp8cba. Some of these also offer additional features like counting clicks 
and recording statistics about your visitors. DwarfURL and DecentURL are among the user-
friendliest of these.

Learn to love your browser. If you have to spend time online, you should be doing your best 
to make it as pleasant and safe as possible. Why be a frog in a pot? 
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